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What is a social network analysis? 
 
Social network analysis (SNA) is a method by which one can analyze the connections 
across individuals, groups or institutions. SNA allows us to examine how political actors 
or institutions are interrelated, and focuses on interactions, or relationships, instead of 
on individual behavior. 

 
There are three different levels of social analysis that are determined by the scope and 
information included:  
 
Ego networks include data on a respondent (individual or organization) and the people 
or organizations they are connected to.  
 
Partial networks extend slightly beyond the ego network, with some amount of tracing 
to reach contacts of contacts. It is something less than a full account of connections 
among all pairs of actors in the relevant population.  
 
A complete or “global” network includes data on all actors within a particular (relevant) 
boundary. Global networks are never exactly complete due to missing data, but 
boundaries are set. 

 
Why create a social network analysis? 
 
“Goods” travel through contacts between actors, which can reflect a power distribution 
or influence attitudes and behaviors, and our understanding of social life improves if we 
account for this social space. Patterns of inter-actor contact can have effects on the 
spread of “goods” or power dynamics that could not be seen focusing only on individual 
behavior. Social network analysis can help us improve organizational effectiveness 
(internal), can help us understand complexity and systems (external), and can help 
identify knowledge leaders (internal – staff, external – organizations). 
 
What is Kumu? 

 
Kumu is a web-based application that allows users to visually map relationships and 
understand and talk about complex systems. “Kumu” is Hawaiian for “source of 
wisdom,” and was created to help bring clarity to complex social problems. The 
founders created Kumu with the belief that our society is facing many, complex and 
difficult problems that can only be resolved through breaking down those complex 
systems to form understanding. 

 
Basic Kumu Terminology 
 
Social network analysis and Kumu have a language all their own, and there are a lot of 
interchangeable terms in the lingo. Below is a list of the terms Kumu uses to describe 



5 
 

social network analysis that will set you up for a base understanding of how to navigate 
Kumu and our map. 
 
Element: Elements are the actors in the map, which, in this case, are the organizations. 
Elements are depicted as colored circles. 
 
Connection: Connections describe the relationship between two elements, or actors. 
Connections are depicted as colored lines that run between the elements.  
 
Type: Types exist for both elements and connections, and are created by the user. Types 
are used to categorize the element or connection. Each element and connection can 
only have one type. 
 
Tag: Tags are similar to types, in that they categorize the element or connection. 
Because each element and connection can only have one type, tags allow the user to 
further categorize the elements and connections. Each element and connection can 
have multiple tags. 
 
Decoration: Decorating is Kumu’s term for applying rules to elements and connections. 
Decoration rules change the physical appearance of the element or connection. 
 
Filter: Filtering lets you change your map view by selecting which elements, 
connections, types, and tags you want to include or exclude in the view. 
 
What information can SNA provide us (in Kumu)? 
 
Kumu allows users to run metrics that help break down these systems and identify areas 
for solution creation. Below is a list of the metrics users can run in Kumu, what they 
measure, and their importance. 
 
Degree: Degree measures the number of connections for a given element, and Identifies 
local connectors and hubs. Elements with a high degree are not always the most 
influential or connected to the wider network 
 
Closeness centrality: Closeness centrality measures the distance from one element to all 
other elements and identifies those with high visibility about what’s happening across 
the network. These people, or organizations can quickly spread information (good or 
bad) across the network. 
 
Betweenness centrality: Betweeness centrality measures the number of times an 
element lies on the shortest path between two other elements, and identifies key 
bridges, or those who control the flow of information across a network. These people or 
organizations may be bottlenecks or single points of failure. 
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Indegree: Indegree measures the number of incoming connections for an element. 
Elements with high indegree are the leaders, looked to by others as a source of advice, 
expertise, or information. 
 
Outdegree: Outdegree measures the number of outgoing connections for an element. 
Elements with high outdegree can reach a high number of elements and spark the flow 
of information across a network (but may not be the most efficient at spreading the 
information). 
 
Reach (two-step out): Reach (two-step out) measures the portion of the network within 
two steps of an element. Elements with high reach can spread information through the 
network through close friend-of-a-friend contacts. 
 
Reach efficiency: Reach efficiency normalizes reach by dividing it by size (number of 
neighbors). Elements with high reach efficiency are less connected but gain more 
exposure through each direct relationship. 
 
How to create your own SNA in Kumu 

 Go to Kumu.io 

 Click “Sign Up” and create your account 

 Follow Kumu’s “Zero to Kumu in 3 Simple Steps” to become more familiar with 

social network analysis, what you can do with Kumu, and how to do it 

 When you feel ready to create your own map in Kumu, select “New Project” 

 Give your project a name and brief description 

 Choose whether to have your map be public or private 

o Public maps can be viewed by anyone, but not altered 

o Private maps cannot be viewed or altered by anyone unless invited 

 Four map options will be presented to you to choose from 

 For our purposes, the “Stakeholder” map will likely be the best choice 

 Name your map 

o You can have multiple maps within a project so you can give the map the 

same name as your project or a different name depending 

 Create your map! 

 A blank screen will appear 

 On the left of the screen will be a field for typing the description of your map 

o Hold your cursor over the “Add Map Description,” and a pencil icon will 

appear 

o Click the pencil icon and a text box will appear for you to add your text 

o Formatting text 

 Bold – Type two * before and after any text you wish to be in bold 
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 Example: If you want the word “test” to be bold type it as 

follows: 

o **test** map   

 Italic – Type one * before and after any text you wish to be in 

italics 

 Example: If you want the word “map” to be italic type it as 

follows: 

o Test *map* 

o Click “done” when you’re done adding and formatting text, and it will 

appear as you formatted it 

 
Figure 1 Example of how to format bold and italics text in Kumu 
 

 
Figure 2 Example of what Figure 1 will look like once you select “Done” 

 

 You can manually create your map by adding elements and connections, or you 

can import data to speed along the process 

o Importing data 

 Create two separate spreadsheets – one for elements and one for 

connections 

 Save your spreadsheets in either .xlsx or .csv file formats  

 Element spreadsheet 

 Must have a column labeled “Label” – this will be the 

element’s name 

 Optional columns: 
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o “Type” – typing is the easiest way to filter your 

map view -  type elements in whatever way is 

relevant to your project 

 Examples: Typing by sector, teams, project, 

etc. 

o “Description” – type the text that will appear in the 

element’s description sidebar 

Figure 3 Example of how to format the Element spreadsheet  
 Connection spreadsheet  

 Must have a column labeled “From” and a column labeled 

“To” – these will be the two elements that the connection 

will lie between 

 Important note: The “From” column needs to be the first 

column, followed by the “To” column 

 Optional columns: 

o “Type” 

o “Label” 

o “Description” 

 
Figure 4 Example of how to format the Connection spreadsheet  

 Important note: If you are trying to have multiple 

connections between two elements, this will have to be 

done manually 

o Example: If element “THE LITERACY COALITION OF 

CENTRAL TEXAS” and element “Ace Tailors 

Downtown” interact in two different ways that  

you want represented by two separate connections 

o When importing, you can list one connection 

between two elements in the spreadsheet – 

additional connections between those same two 

elements will have to be added manually 

 To import your spreadsheet, follow these steps: 

 Click the green button with the + sign at the bottom of the 

screen 

 Select “Import” 
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Figure 5 How to import existing data into the map 

 

 Select XLSX or CSV tab depending on your file formats  

 Scroll to the bottom and click “Select .xlsx file” or “Select 

.csv file” respectively 

 Select your element file – import your element file first – 

you cannot have connections without the elements they 

connect to 

 It should say that you have no errors – click “Save import” 

o If you have errors, fix the errors and resubmit 

 Follow this process with the connections spreadsheet   

o Manually adding elements 

 Elements are our actors  

 At the bottom center of the screen is a round green button with a 

+ sign  

 Click the button and a menu of options will appear 

 
Figure 6 How to add an element or connection 

 
 Select “Add element” 
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 A text box will appear to add a label to the element – add your 

label and hit “enter” 

 This will be the name of the person/organization 

 Example “Literacy Coalition of Central Texas” 

 A circle will appear on your map with your label 

 Adding element descriptions 

 Click on the element 

 A sidebar will appear on the left-hand side of your window 

with your element label 

 Click the box in the sidebar that reads “ADD DESCRIPTION” 

 A text box will appear that you can add text to 

o Add whatever descriptors you feel are relevant 

 Organization description content ideas: 

 Mission statement 

 Programs 

 Website 

 Adding element image 

 In the element’s descriptor sidebar, click on the picture of 

a camera in the upper right hand corner 

 A window will pop up requesting the image’s URL 

 Make sure when copying an image you select the “copy 

image address” option 

 Click “Save” and the image will appear both in the 

element’s descriptor sidebar and on the element itself on 

the map 

 How to get the image off the element while keeping it on the 

element’s descriptor sidebar 

 Click the Settings Menu button on the map (4th button on 

the upper right hand corner) 

 At the bottom of the Settings Menu select “Switch to 

Advanced Editor” 

 A terrifying set of code will pop up – do not be scared, you 

got this 

 Add “element-image-visibility: hidden” to the @settings 

block 

o It should look like this: 
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Figure 7 What the code should look like in the advanced editor to 
remove the images from the map view 

 
o Ignore the “element-color: #00000;” part of this 

code  

 Adding element types 

 Types are the easiest way to filter map views –type 

elements in whatever way is relevant to your project 

 Examples: Typing by sector, teams, project, etc. 

 In the element’s descriptor sidebar, click on the “ADD 

ELEMENT TYPE” text and a drop down menu will appear 

with “Person” and “Organization” a selector options 

 Use these pre-existing options or add your own by clicking 

on the “new value” text box and adding your text 

 Hit enter 

 
Figure 8 Example of how to add a new type to an element  

 
 Adding element tags 

 Tags can also be used to further filter and classify 

elements –tag elements in whatever way is relevant to 

your project 

 In the element’s descriptor sidebar, click on the “ADD 

TAG” box 

 Type in the title of your desired tag and hit enter 
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Figure 9 Where to add a tag to an element 
 

 
Figure 10 Example of how to select a tag for an element  

 
 Adding element decoration rules 

This changes the way your element physically appears – 

you can change an element’s color, shape, and size, as well 

as add an image, a bullseye, and a shadow 

 In the element’s descriptor sidebar, there are 4 icons on 

the bottom right-hand side 

 Select the icon that is third from the bottom and looks like 

a paint drop – this takes you to the decoration screen 

o This screen can also be reached by going to the 

Settings Menu and clicking on the “Decorate” tab 

 
 

Figure 10 
The 
element’s 
button 
options. The 
decorate 
button is 
the one that 
looks like a 
paint drop, 
third from 
the top 

Figure 12 
The map 
buttons. 
The bottom 
button 
takes you to 
the settings 
page 
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Figure 13 The Decorate Menu 

 

 Once inside the decoration menu, select “Add element 

rule” 

 A decoration window will pop up 

 Any element tags and types you have already selected for 

this element will appear under “Instructions” 

 Select any types and tags you wish to apply to this rule 

across the board 

o Example: If you want all elements typed “Business 

Sector” to be blue, make sure you click on the 

“Business Sector Element Type” – this will ensure 

any element you type as “Business Sector” in the 

future will automatically become blue 
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Figure 14 Example of how to change the color of an element type 

 

 Decorate the element how you see fit 

 If you want this rule to show up in a legend that appears 

on the map 

o Scroll down to the “Label for Legend” field and type 

the text you wish to appear on the legend 

o Example: If you want your viewer to know that 

blue elements represent the business sector, type 

“Business Sector” into this field 

 Click “Done” 
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Figure 15 Example of how to add an element rule to the map legend 

 
 Deleting elements 

 Click on the element 

 Click “delete” button on your computer or: 

 Click on the trash can icon in the bottom right hand corner 

of the element’s description sidebar 

 A window will pop up asking you if you’re sure – click “ok” 

o Manually adding connections 

 Connections represent the relationships between our elements 

 At the bottom center of the screen is a round green button with a 

+ sign  

 Click the button and a menu of options will appear 

 Select “Add connection” 

 Important note: You have to already have two elements 

on your map in order to create a connection 

 A box will appear with two text boxes separated by the word “to” 

 If you had clicked on an element prior to adding a 

connection, one of the text boxes will automatically be 

filled with that element 

 Type in the two elements you wish to be connected – one in each 

box 

 As you begin to type, a list of all created elements will 

appear for you to select from 

 Click enter and a line will appear on your map connecting 

the two elements 

 
Figure 16 Example of how to add a connection between two elements 
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 Adding connection descriptions 

 Click on the element 

 A sidebar will appear on the left of your window with your 

element label 

 Click the box in the sidebar that reads “ADD DESCRIPTION” 

 A text box will appear to add text  

o Add whatever descriptors you feel are relevant to 

describe the connection’s meaning 

 Adding connection types 

 Types are the easiest way to filter map views –type 

connections in whatever way is relevant to your project 

 Example: by program 

 In the element’s descriptor sidebar, click on the “ADD 

CONNECTION TYPE” text and a drop down menu will 

appear  

 Click on the “new value” text box and add your text 

 Hit enter 

 Adding connection tags 

 Tags can also be used to further filter and classify 

connections –tag connections in whatever way is relevant 

to your project 

 In the connection’s descriptor sidebar, click on the “ADD 

TAG” box 

 Type in the title of your desired tag and hit enter 

 Adding connection decoration rules 

 This changes the way your connection physically appears – 

you can change an connection’s color, size, and style  

 In the connection’s descriptor sidebar, there are 4 icons on 

the bottom right-hand side 

 Select the icon that is third from the bottom and looks like 

a paint drop – this takes you to the decoration screen 

o This screen can also be reached by going to the 

Settings Menu and clicking on the “Decorate” tab 

 Once inside the decoration menu, select “Add connection 

rule” 

 A decoration window will pop up 

 Any connection tags and types you have already selected 

for this connection will appear under “Instructions” 

 Select any types and tags you wish to fall under this rule 
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o Example: If you want all connections tagged “Past” 

to be dashed, make sure you click on the “Past 

Connection Tag” – this will ensure any connection 

you tag as “Past” in the future will automatically 

become dashed 

 
Figure 17 Example of how to change the style of a connection tag 

 

 Decorate the connection how you see fit 

 If you want this rule to show up in legend that appears on 

the map 

o Scroll down to the “Label for Legend” field and type 

in the text you wish to appear on the legend 

o Example: If you want your viewer to know that 

dashed connections represent past relationships, 

type “Past Relationships” into this field 

 Click “Done” 

 Adding connection directions 
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 Every connection can be directed or undirected 

 Directed connections mean “goods” flow in one direction 

o Example: Element A provides Element B a good 

 Mutual connections mean “goods” flow in a reciprocal 

manner 

o Example: Element A provides Element B a good and 

Element B provides Element A a good 

 Adding directionality to your connections will create one 

or two arrows at the ends of the connection line on your 

map 

 In the connection’s descriptor sidebar, select the top icon 

in the bottom right-hand corner that looks like two arrows 

going in opposite directions 

 Select “Mutual” if you want arrows going in both 

directions of your connection line 

 
Figure 19 Example of a mutual directionality between two elements  

 

 Select “Directed” if you want an arrow on only one side of 

your connection line  

o If the arrow shows up on the wrong side of the line, 

click the Direction icon again and click “Reverse” 

 If you need to change a directed connection line back to 

undirected, click the Direction icon and click “Undirected” 

 Multiple connections between two elements 

 Example: If element “THE LITERACY COALITION OF 

CENTRAL TEXAS” and element “Ace Tailors Downtown” 

Figure 18 The 
connection’s 
button options. 
The Direction 
button is the 
top button with 
two arrows 
going in 
opposite 
directions. 
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interact in two different ways that you want to be 

represented by two separate connections 

 When you add a second connection between two 

elements they will automatically stack on top of each 

other 

 In order to reshape the connection lines you will have to 

pin down the two elements (everything floats in Kumu) 

 Click on the element you wish to pin and select the first 

icon in the bottom right hand corner of the element’s 

description sidebar that looks like a pushpin 

 Repeat for the other element involved in the connection 

 You can then click on the connection, hold down the 

cursor, and move the connections off one another 

 
Figure 21 Example of what two connections between two elements looks like  

 
 Deleting connections 

 Click on the connection 

 Click “delete” button on your computer or: 

 Click on the trash can icon in the bottom right hand corner 

of the connection’s description sidebar 

 A window will pop up asking you if you’re sure – click “ok” 

o Changing/deleting existing element and connection rules 

 All existing element and connection rules can be found in list 

format under the Settings Menu in the “Decorate” tab 

 Next to every rule is a pencil icon and an X icon 

 Clicking the “X” icon will delete the rule immediately 

 Clicking the pencil icon will bring up the decoration builder 

window and allow you to make any changes to that rule 

Figure 20 
Example of 
when the 
pin button 
is selected, 
meaning 
the 
element 
has been 
pinned 
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Figure 22 Example of the Decorate Menu where you can change or delete existing decoration rules 

 

 Navigating your map  

o Click on any element to access that element’s description sidebar 

 A window on the left hand side of the screen should appear with 

the description information you added 
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Figure 23 Example of the element’s descriptor side bar, which pops up when you click on an element 

 
o Click on any connection to access that connection’s description sidebar 

 A window on the left hand side of the screen will appear with the 

information you added 
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Figure 24 Example of the connection’s descriptor side bar, which pops up when you select a connection line 

 
o Filtering – you can filter by element and connection type as well as tags 

to get an easier to digest, and more specific views of your map 

 Filtering by element type 

 In the upper right hand corner of the map are 4 buttons.  

o The top two allow you to zoom in and out 

o The third will automatically zoom to fit the whole 

SNA on the screen 

o The fourth takes you to the Settings Menu which 

will open on the right hand side of you screen 

 Once in the Settings Menu, click the “Filter” tab  

o On the left you will see a list of all the element 

types, with all types checked 

o Uncheck boxes to remove those element types 

from the map’s view 
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Figure 25 Example of the Filter Menu, where you can filter your map view  

 
o Important note: If you are creating an egocentric 

SNA and want the element who’s ego you are 

mapping to stay present while filtering, make sure 

that element is typed individually and always leave 

that type box checked  

 Filtering by element tag 

o Elements tags can be used to further filter 

o To filter by tags, follow these steps 

 Click on the settings menu button – 4th on the 

upper right hand corner of the map 

 Click the “filter” tab 

 Scroll to the bottom to the fields labeled “Also 

include” and “But ignore” 
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Figure 26 Shows where in the Filter Menu to filter by tag 

 
 Select the “Also include” field 

 A Selector Builder window will pop up with 

three fields 

 In the first field (left) click the drop-down menu 

and select “tags” not “tag” 

 Leave the middle field “is” 

 Click in the third field (right) and type the tag 

you want to show in the map 

 Click “Use Selector” 

 
Figure 27 Example of how to select which tag to filter the map view by 

 
 In the filter tab of the settings menu select the 

“But ignore” field 

 The same window will pop up 

 In the first field (left) select “tags” 

 Keep the middle field “is” 
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 In the third field (right) type the tag you do not 

want to show in the map 

 Click “Use Selector” 

 Filtering by connection type 

 In the upper right hand corner of the map are 4 buttons.  

o The top two allow you to zoom in and out 

o The third will automatically zoom to fit the whole 

SNA on the screen 

o The fourth takes you to the setting menu which will 

open on the right hand side of you screen 

 Once in the setting menu, click the “Filter” tab  

o On the right-hand side you will see a list of all the 

connection types with all types checked 

o Uncheck boxes to remove that connection’s type 

from the map view 

 Filtering by connection tag 

 Connection tags can be used to further filter 

 To filter by connection tags, follow these steps: 

o Click on the settings menu button – 4th on the 

upper right hand corner of the map 

o Click the “filter” tab 

o Scroll to the bottom to the fields “Also include” and 

“But ignore” 

o Select the “Also include” field 

o A Selector Builder window will pop up with three 

fields 

o In the first field (left) click the drop-down menu 

and select “tags” not “tag” 

o Leave the middle field “is” 

o Click in the third field (right) and type the tag you 

want to show in the map 

o Click “Use Selector” 

o In the filter tab of the settings menu select the “But 

ignore” field 

o The same window will pop up 

o In the first field (left) select “tags” 

o Keep the middle field “is” 

o In the third field (right) type the tag you do not 

want to show in the map 

o Click “Use Selector” 
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 Filtering by multiple types and tags at once 

 You can filter by both element and connection types, and 

tags simultaneously, as well as filter by several at once. 

 Multiple types 

o Leave all element and connection types you want 

visible checked 

 Multiple tags 

o Scroll to the bottom of the “Filter” tab to the fields 

“Also include” and “But ignore” 

o Select the “Also include” field 

o A Selector Builder window will pop up with three 

fields 

o In the first field (left) click the drop-down menu 

and select “tags” not “tag” 

o Leave the middle field “is” 

o Click in the third field (right) and type the tag you 

wish to appear in the map 

o Under the third field (right) click the button that 

reads “and” 

o Another set of three fields will pop up 

o In the first field (left) click the drop-down menu 

and select “tags” 

o Leave the middle field “is” 

o Click on the third field (right) and type the 

additional tag you wish to appear in the map 

o Click “Use Selector” 

 
Figure 28 Example of how to filter by multiple tags 

 
o In the filter tab of the settings menu select the “But 

ignore” field 
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o The same window will pop up 

o In the first field (left) select “tags” 

o Keep the middle field “is” 

o In the third field (right) type the tag you do not 

wish to appear on the map 

o Under the third field (right) click the button that 

reads “and” 

o Another set of three fields will pop up 

o In the first field (left) click the drop-down menu 

and select “tags” 

o Leave the middle field “is” 

o Click on the third field (right) and type in the 

additional tag you do not wish to appear in the 

map 

o Click “Use Selector” 

 Important note: If you have made any changes to the view, at the 

bottom of the settings menu it will read “You’ve made changes to 

this view REVERT” 

 You can always click “REVERT” to go back to the original 

view 

 
Figure 29 Shows where to revert any changes made to the map view 

 

 Running Metrics 

o What metrics can you run? 

 Degree: Degree measures the number of connections for a given 

element. In general, elements with high degree are the local 

connectors and hubs. 

 Closeness Centrality: Closeness measures the distance from one 

element to all other elements. In general, elements with high 

closeness have the most visibility into what's happening across 

the network. 

 Betweenness Centrality - Betweeness measures the number of 

times an element lies on the shortest path between two other 

elements. In general, elements with high betweeness are key 

bridges and those who control the flow of information across a 

network. 
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 Indegree: Indegree measures the number of incoming 

connections for an element. In general, elements with high 

indegree are the leaders, looked to by others as a source of 

advice, expertise, or information. 

 Outdegree: Outdegree measures the number of outgoing 

connections for an element. In general, elements with high 

outdegree can reach a high number of elements and spark the 

flow of information across a network (but may not be the most 

efficient at spreading the information). 

 Size: Size measure the number of neighbors an element has (plus 

the element itself). It's similar to degree but counts elements 

instead of connections. 

 Reach (two-step out): Reach measures the portion of the network 

within two steps of an element. In general, elements with high 

reach can spread information through the network through close 

friend-of-a-friend contacts. 

 Reach Efficiency:  

 Reach efficiency normalizes reach by dividing it by size (number of 

neighbors). In general, elements with high reach efficiency are 

less connected but gain more exposure through each direct 

relationship. 

o How to run metrics  

 At the bottom right hand corner of your screen are 5 icons 

 Select the icon that looks like a block 

 
Figure 30 Shows the map’s buttons. The Blocks button looks like a block and is second from the left 

 
 Select “Social Network Analysis” 

 Click on the drop-down menu that allows you to choose which 

metrics to run 

 Select the metric you wish to run and select the “Discover 

elements with…” button 
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Figure 31 Example of how to select and run metrics  

 
 The top 20 of your elements will appear 
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Figure 32 Example of what it will look like once the metrics have been run 

 

 Select the “Show the” drop-down menu that defaults to 20 

to show more elements 

 Sharing your map 

o Embedding 

 Embeds allow you to share and display maps on your own blog or 

website, or send a URL link via e-mail. The embedded version is an 

interactive read-only copy. Viewers can click, filter, and even 

change rules without changing your original version. Viewers will 

not be able to save any changes they make or export any data. 

 On the bottom right hand side of your screen are several icons 

 Select the right most icon that looks like three dots 

 Click “Share/embed this map” 
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    Figure 33 Shows where to go to embed the map 

 
 A window will pop up allowing you to select “include map 

overview in sidebar” and/or “include current position and scale” 

 “Include map overview in sidebar” allows you to include the 

sidebar in the embedded map. If you don't select this option the 

embedded version will have the map displayed full screen until 

you click on an element or connection and then the profile will 

expand. 

 “Include current position and scale” allows you to override the 

default positioning of the map and instead use the current 

position and zoom of the map as displayed in your browser. 

 Check relevant boxes and click “Create embed/share link” 

 A link will appear below that you can share with others to access 

the map 
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Figure 34 Shows how to create an embed link 
 

 The link will always link to the most updated version of the 

map 

 I.e.: if you send the link out on 3/20 and change the map 

on 3/30, the 3/20 link will show the 3/30 version of the 

map after that date 

o Invite others to edit your map (collaborators) 

 There may be cause for individuals to be able to add to your SNA 

 Important note: Anyone you wish to invite to edit your map must 

already have a Kumu account 

 To add a collaborator, click the menu button in the upper left 

hand corner of your screen (icon is three horizontal lines) 
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Figure 35 The project menu screen 
 

 Select the members tab 

 Type the collaborator’s e-mail or username into the text box in 

the upper right hand side 

 Click “Add contributor” 

 
Figure 36 Shows where to add contributors to the map 
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 This person will be able to change anything in your SNA 

permanently, so choose wisely 

o Taking a screenshot of your map 

 Before taking a screenshot of your map, ensure the map is in the 

position you want it 

 You can change where in the screen the map is positioned by 

clicking outside of the map, holding down, and moving your 

cursor 

 You can fix the position of your elements by pinning them down 

 Click on the element 

 In the element’s description sidebar, select the icon in the 

shape of a pushpin. It will turn blue when your element is 

pinned 

 To reshape a connection line, first pin both elements it is 

connected to, then click on the element, hold down your 

cursor, and reposition 

o Insider wisdom: These connections often have a 

mind of their own and don’t always move where 

you tell them to move, sometimes automatically 

stacking on top of each other 

 In the bottom right hand side of your screen, select the right most 

icon that looks like three dots 

 
   Figure 37 Shows where to go to screenshot the map 

 

 Select “ Capture screenshot” 

 A window will appear showing you what your screen shot 

looks like and instructing you on how to save it 

 Exporting map data 
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o You can export your map data into either a .xlsx or .json file 

o An .xlsx export will save only the data, not the Kumu rules you applied to 

that data 

o In the bottom right hand side of your screen, select the right most icon 

that looks like three dots 

 
Figure 38 Shows where to go to export the map data  

 

 Select “Export .xlsx” or “Export .json” respectively 

 It will generate a downloaded copy for you to open 

o Insider wisdom: Be sure to check both the “from” and “to” columns of 

the exported connection spreadsheet if you’re looking for a connection. 

The export mixes some of these up, and if you’re only searching one 

column it may look as though data is missing when it’s not. 

 True blueprint copy - .json file import 

o If you want to easily copy your map with all data and decoration rules, 

the .json import is the way to go 

o You will first need to export a .json file of the map you wish to copy 

 Open your map 

 At the bottom right hand corner of your screen, select the corner 

most button that looks like three dots 

 Click “export .json file” 
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Figure 39 Shows where to go to export a .json file 

 

 This will download a copy onto your computer 

o Once you have the exported file, you will need to open an entirely new 

project 

o Click on the menu button in the top right corner of your screen 

o Select the “New Project” tab 

 
         Figure 40 Shows where to select a new project 

 

o Enter your project name and description 

o Decide if you want your map to be public or private 

o Click “+NEW MAP” 
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Figure 41 Shows how to create a new project 

 
o You will be prompted to the map type selection screen 

o At the bottom of the screen it will read “or import .json blueprint” – click 

this 

 
Figure 42 Shows where to import a .json blueprint copy of the map 
 

o Click “Choose file” and select the downloaded .json file 

o Click “Import .json blueprint” 

o It should appear! 

o Important note: If you’re wanting to import a .json file into a new map in 

an existing project, be on the lookout. There are often errors when 

copying into projects that already have data. If you choose to do this in 

new map, it will say that it was a success and nothing will show. Make 

sure to check the drop down menu of maps in your project. Importing 

this way automatically creates a separate map without notifying you. The 
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map will probably be in the drop down menu, with the same title it had 

originally.   

Insider tips 
 Check out Kumu’s documents – they are very helpful 

o Click the menu icon in the upper right hand corner of your screen 

o Select the “Help” tab 

o Click the link that reads “ Read the docs” 

 
Figure 43 shows where to access Kumu’s documents pages  

 
o Important note: Some of the language and instructions in these docs 

assumes the reader has an intermediate level of tech and coding 

knowledge 

 Check out Kumu’s issues page 

o Click the menu icon in the upper right hand corner of your screen 

o Select the “Help” tab 

o Click the link that reads “Open an issue” 

 
Figure 44 shows where to access Kumu’s issues page  

 
o This will bring you to a user forum where issues are presented and 

addressed 
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o Search your issue to see if the Kumu team has answered this for another 

user 

o Opening a new issue 

 If you cannot find the information or solution you’re looking for, 

open a new issue  

 Kumu is quick in their responses and incredibly kind, patient, and 

helpful 

 Once on the issue page, click the button in the right hand corner 

that reads “New Issue” 

 Title and describe your issue 

 Click “Open new issue” when you are ready to submit 

 An e-mail will be sent when Kumu has responded, and the 

response will appear in the issue page 

o Have confidence in your abilities and be patient! 

 Kumu can be finicky at times and can require one to stretch their 

tech savvy muscles perhaps more than some of us would like 

 Kumu is an incredibly powerful tool to allow organizations to learn 

so much information about themselves and the community in 

which they operate, so stick with it. The outcome is worth the 

added effort 

 
 

 
 
 


